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Knowledge Base Article: Article 235

How to Schedule a Task Exporting Data to a Database

Date: May 4th, 2012

Description:
Click&DECIDE Builder can export data to any database, if the Data Source has been created for this database.
The target of this document is to explain how to create a task, and then schedule this task to export data from a
query to this database automatically.

1. Check or create the data source for this database:
If you wish to export data to an iSeries for example (or other database) you first need to create a data source
connecting to this database. If you are using Builder not connected to Administration Manager refer the Query User
Guide and see page 7 how to create a data source:

http://www.clickndecide.com/sites/default/files/assets/files/resources/clickndecide bai query user quide 1.pdf

If you are using Builder connected to Administration Manager refer the Administration Manager User Guide and see
page 11 how to create a data source:

http://www.clickndecide.com/sites/default/files/assets/files/resources/clickndecide bai administration _manager_user
guide 0.pdf

Note: you cannot export data to a data source secured by Click&DECIDE in Administration Manager, for security
reasons.

2. Create an output format for this database
Start Click&DECIDE Builder then use the command Tools> Output Configuration to open the Output format
configurator. Add a new output format using the Database Type as in the following example:

' "y

Mew Cutput Format

h
QK
Output Format Mame
S Cancel
iSeries
Output Format Type
Databasze - ]

., -

Click OK, and then make a right mouse click on the new icon created to go to the Properties:

In the Connection Tab select the iSeries data source you have created (without Security if under Administration
Manager):
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Connection | Options
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----- -E.'] Index Maintenances

..... Eﬁl informix

..... 1

..... 4 Iseries connect

----- ' iSeries TCPIP V5R2
----- A iseries_connect_ns
..... A iseries_GGO

..... %l Licences

Then in the Options Tab select the required options if needed:

iSeries Properties

Convert field names to uppercase
Replace blanks by *_'
Keep regular chars only ( [0..9], [A..2] )

Maximum column name length (0 = no limited):
[¥|Rename duplicate heading with number!

Export Char fields as Varchar by default

Click OK and Save and Quit the Output format configurator.

Create UNICODE Char fields by default if possible

]

3. Optional but recommended: create from Builder an output format file (*.fmt):
Start Builder and open a query that you want to export to the iSeries (or your new Output format to Database). In the
following example we will use the demo_multicriteria query from SQL Server and send the data to the iSeries:

From Builder open this query and click the Export Data icon, you get the output format list:

Select Output Format

- XML Data

- ASCIL

i - ASCII Seguential
[J- Database

- MSACCESS

- ACCESS

- Licences 2008

- Local SQL Server

o< |
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Select the required output format, iSeries in this example and click OK. Enter, if needed the parameters required by
the query then click OK: you will get this dialog:

ﬁ

Destination | Description | Users | Options | Connection |

Destination Table Mame

[ Browse... ][Cl"lediTable Presence ]

Write Mode
(71 Create new table
() Write data if table exists butis empty
. (7 Append data if table already exists
I (") Delete the table contents if table already exists

i@ Drop the table if table already exists, |
then create a new one

Load/Save...

Lok || cancel || ooy |

In the Destination Table you can enter (or browse to search) the Library and Table destination names (example
Library/Table for an iSeries).

The Write Mode should be the one used later when the table will already exist (if the table does not exist, it will be
created the first time). In the above example we have chosen to drop the table and create it again each time
because it is faster than delete the table content and send the new data inside.

Optional: you can access the Description Tab to modify and specify column names, column types, length and
numeric decimals, such as this example:

The Code field has been changed to Integer type.
The “Salesman Name” field name has been changed to “Salesman”
The Date field has been changed from TimeStamp Type to Date Type format

The Amount field has been changed from Float Type to Decimal Type Length 8 and 2 decimals.
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ﬁ

Destination | Description | Users | Options | Connection |

Fields

Area
Code
Salesman
DateSaold
Amount

Selected Field Description

Field Mame:

Amount
Type: | Decimal -
Size: a Dedmal 2

Mull autheorized
[ ] Create UNICODE field if possible

Load/Save...

Lok || cancel || ooy |

Click&DECIDE NSI & BAI | KBA

Optional: you can access the Users Tab to specify other UserID so that other people can use the created table,

such as this example:
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ﬁ

| Destination | Description | Users | Options | Connection |

Users allowed to use the result table
DIDIER.
GG0
Add ][ Remove ]
Load/Save
o J[ cancel J[ ooty |
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Save your configuration using the Load/Save button, the file will be saved in the directory C:\Program Files\Click
and DECIDE\BAI\Templates\Database Output with the *.fmt extension:

Click “Save Settings” and enter a file name, for example demo_multicriteria_for_iSeries.fmt.

Note that later, when exporting again the same query to iSeries, you can quicky load the same “fmt” file to retrieve
your output configuration.

Then click Cancel if you don’t want to create the table now, or click OK if you wish to test the exportation of this
query to the iSeries.

4. Add the output format for this database to the concerned query in a Menu
Now open the Menu in Administration Manager that will contain the branch to the query to be run and send data to
the iSeries: example, we will add a branch in the BAlI Demonstration Menu:

S %GRS alaRERE
! File Edit Inset View Help

Iﬁ_ root
--ﬁ Dynamic Reports

..........................................

=-031

----- g_';' Demao Multicriteria with parameters
----- g_';' Most Recent Sale for each Salesman
----- ¢ & Mative SQL with parameter

----- L_f' Query with criteria on subselect

----- L} Mative SQL with criteria on subselect
----- i xport DemoMultiCriteria to iSeries
-3 Dynamic Cubes

-3 Dashboard Applications

-3 Web Queries

Insert a dynamic query and give a name such as “Export QueryName to iSeries” then double-click to open the
properties: specify the query to be run (here demo_multicriteria)

Click and DECIDE Query E

Gereral | Format | Icon

Click and DECIDE project file name

SeDATASET _DEMO%: \DemoWWeb\Click and Decde Web Demonstration.w

Browse...

Item —

| deme, multieriteria | !—ﬁ

Visible in browser

ok || canesl || oy || Hep

Then go to the Format Tab and add the Output Format to the required Database: iSeries in our example.
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Click and DECIDE Query E
Format | Icon
|
Excel 2007
iSeries
Licences 2008 D
Local 0L Server
el 7
Template File/Sheet Name
Browse...
Write Mode or Cell[Mode]:
ok J[ cancel |[ ooy |[ hHep |

Now, click the Browse button to open the Database Output dialog box:

Destination

Destination Table Mame

Browse... ][ Check Table Presence

Write Mode
@ Create new table
() Write data if table exists but is empty
(") Append data if table already exists
I (") Delete the table contents if table already exists

(7 Drop the table if table already exists,
then create a new one

Load/Save...

o ) [cma ][ s |

Click Load/Save to search for the file.fmt created for the query demo_multicriteria:

E.I:EE 3| |. |
Load Settings...

oK ] [ Cancel ] |_ SWES]EI‘“IIE]S...
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Select the file previously created, in our example demo_multicriteria_for_iSeries.fmt, that will retrieve the
configuration, for the Library/Table name and the Write Mode:

Destination

ﬁ

Destination Table Mame

[ Browse... ][Cl"lediTable Presence ]

Write Mode

(7} Create new table
() Write data if table exists butis empty
. (7 Append data if table already exists
I (") Delete the table contents if table already exists

(@) Drop the table if table already exists,
then create a new one

Click OK to transfer the configuration into the Menu branch:

Format | Ican

Click and DECIDE Query E

Excel
Excel 2007
g/ iSeries
Licences 2008
Local SCL Server

el

|3

Template File/Sheet Mame

SAMPLE/DEMOTABLE

Write Mode or Cell[Mode]:

Browse...

DROP|

| ok

J [ concel || ooty [ Hep |

Note: if you don’t wish to use a file.fmt, you can manually enter here in the Menu the LIBRARY/TABLE name and
the Write Mode. The other parameters of the file.fmt are not saved in the Menu level (such as column names,
column types, column length etc. but this can be done later when defining the task).
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Click OK to validate and save the Menu.

5. Creating the Task in the Web Portal
Now, start the Web Portal from any authorized location, Server or workstation, under a login that will give you
access to this Menu (the Menu access is defined in Administration Manager for the concerned User Groups).

Select the query to be run, in the branch “Export DemoMultiCriteria to iSeries”:

@D Click&DECIDE

Dynamic Queries

L? Custorner List without parameter

Web Server Configuration
Menus

—

=BAl Tools
E MSI Reports and Analysis
= NS Utilities
= Web Portal Statistics
= E BAI Dernonstration
[d Dynamic Reports
_1Dynamic Queries
[ Dynamic Cubes
[d Dashboard Applications
[d'Web Queries
[ Report with URL link

L} Demo Multicriteria with parameters

L_f' Most Recent Sale for each Salesman

Refresh the Menu
list by clicking here
if neaded

L} Mative 501 with parameter

L? Cluery with criteria on subselect

L? Mative SOL with critenia on subselect

L} Export DemolultiCriteria to iSeries

The parameters and output format will appear, except the Output to Database that cannot be run from here,
because reserved to users belonging to a Task Administrator Group, for security reasons:

Result

Both Export DemohultiCriteria to iSeries

Area?

| ATLANTIC;CENTRAL

Salesman Mame: |IGNGF:E

Date? (Use key words or a calendar date) |La:t Quarter

Output Format: @ PDF () HTML [ Run

| i)

Click here to create a task

Select, if needed, the criteria to be used, and click the right green icon to create the task: change the default Task

Name and modify, if needed, the criteria you have defined.

As you can see the iSeries output format will appear, so you will be able now to activate it.
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Create Task
Task Mame DemoMultiCriteriaToiSeries
Source
Menu Alias: BAI Demonstration
Menu Itemn: Export DemoMultiCriteria to iSeries
Parameters
S | ATLANTIC; CENTRAL | imatl [
Salesman Mame: |IGNGF1E ||"""||:|
Date? (Use key words or a calendar date) |La:t Quarter | I""IE;I O
Destination
OutputFormat: g, ppe @ HTML ©
Destination Directory (|
Destination File Suffi None v

Change the Output Format to iSeries that will display the predefined configuration saved in the Menu:

Create Task
Task Mame DemoMultiCriteriaToiSeries
Source
Menu Alias: BAI Demonstration
Menu Iterm: Export DemeMultiCriteria to iSeries
Parameters
A | ATLANTIC;CENTRAL | il ]
Salesman MName; |IGHGF1E ||"||:|
Date? (Use key words or a calendar date) |L.ast Quarter |I"‘"IE'.F;;‘I i
Destinaticn

Output Format: = ppe @ gL @ iSeries -

Destination Table |5.-:'.['-,-1F'LE-DE['-,-1GT.-:'.BLE

Write Mode

DataBase Output Format File (*.fmt)

Connection to Output Data Source

User ID

Password

Note that the Destination Table is now the Library and the Table names, not modifiable here for security reason
(only the Administrator who has created the Menu can modify it).

Note that the Write Mode is now the one defined in the Menu, not modifiable here for security reason (only the
Administrator who has created the Menu can modify it).
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Database Output Format File (*.fmt): if you don’t wish to use the file.fmt, leave it blank. (in that case the column
names, column types, column length etc will be the one of the query source, but we recommend to use the FMT file
to avoid mistakes.)

If you wish to use it, just enter the name of the file name without any path (the file must be located in the Server into
the directory C:\Program Files\Click and DECIDE\BAI\Templates\Database Output)

Connection to Output Data Source: if a login is required to export data to this database, enter here your UserID
and Password. The password will be encrypted in the tasks file.

Destination
Output Formati @) ppp @ HTML @  iSeries ¥
Destination Table |5.-1'.['-;1F'LE-DE['-;1GT.-Z'.E!LE
Write Mode
DataBase Output Format File (*.fmt) demo_multicriteria_for_Series.fmt

Connection to Cutput Data Source

UserID QSECOFR

Password TIITIIL

Optional: Send an Alert

Here you can use the Alert Type “Send an e-mail”, only to get an email saying that the task has been done
successfully. (Of course no attachment can be sent with the mail with this kind of output format).

Alert

Send an Alert
Alert Type: e-mail -
From didier@clickndecide.com
To didier@clickndecide.com
Subject Export to iSeries
Text The demo_multicriteria has been sent to the i5enes
Attachment =Destination()

|%| ’ Save ] ’ Cancel ]

When finish, click Save.

The Task Name will appear in the left Tasks List in the Web Portal:
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Scheduled Tasks & Tasks
= [ Scheduled Tasks
‘¥ Click and DECIDE NSI Scheduled Dashboards
':B cubed
_'EJ M5 AGREGATION PURGE
_@ Purge Alerts Tables
_'E‘ southwestquarter
= [ Tasks
@ Continue if first of the month

@ cubed

@ DemoMultiCriteriaToiSeries

6. Creating the Scheduled Task in the Web Portal

Click now the icon New Scheduled Task in the right pane of the Web Portal:

X ”‘j New Scheduled Task

Click&DECIDE NSI & BAI | KBA

and give a name, then add the Task in the Tasks to be run box:

General

Scheduled Task Mame: DemoMultiToiSeries

Available tasks Tasks to be run

Continue if first of the month - iDemoMultiCriteriaToiSeries

cube?

DEMOTOISERIES

HetBeport Authentication Daily Dashboard
HetBeport Authentication Monthly Dashboard
HetBeport Consclidation Aggregaticn and Pu
HetBeport Firewall Daily Dashboard (|
NetBeport Firewall Monthly Dashboard

NetBeport Intrusicon Prevention Syatem Dail
NetBeport Intrusicon Preventicon Svyatem Mont ™

Comments: ~

Active (Scheduled Task Runs at Specified Time)
Frequency

Frequency: Once -

Start Date and Tirme 04,05/2012 16:41:02 (£l

Define the Frequency. (Once, Now, Daily, Weekly, Monthly).

Then define, if needed the Repetition, and finally save the Scheduled Task by clicking the Finish button.
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Repetition
Repeat the Scheduled Task
Interval |1 || Minutes - |
Duration |1 |Hours|':' | Minutes

When running the task, use the following user account: SYSTEM

| Finish | | Cancel |

The new scheduled task name will appear in the left Scheduled Tasks List on the Web Portal:
Web Server Configuration ol
Menus

Scheduled Tasks & Tasks
= [ Scheduled Tasks L7

Eﬁ' Click and DECIDE MSI 5cheduled Dashboards
ESE cubed
Eﬁ[}emuh’luﬂﬂuiﬁeriﬁ
NS AGREGATION PURGE
2 Purge Alerts Tables
e southwestquarter
= [d Tasks
@ Continue if first of the month

@ cubed

@ DemobultiCriteriaToiseries

[#

F ®H &

7. Testing now the Scheduled Task in the Web Portal

If you wish to test immediately the new Scheduled Task you just created, first select this task on the left list and click
the icon Run the Scheduled Task in the right pane of the Web Portal:

-
Run the Scheduled Task
EEEE: The Scheduled Task is ready.

While the task is running the icon will look like:
£
Run the Scheduled Task
geats The Scheduled Task is running...
]
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When the task is done the icon will look like this one if successful:

Run the Scheduled Task
@ The Scheduled Task is ready.
e | Last Run Tirme: 04/05/2012 16:50:51
. Last Run Result: Succeeded

Or can look like this one in case of error:

Run the Scheduled Task
_(p The S5cheduled Task is ready.
i Last Run Time: 04,/05/2012 16:53:52
Last Run Result: Failed

In that case we recommend first to open the Event Viewer and see the error.

This error should give information about the problem (wrong table name, wrong column name, wrong type, wrong
length, conversion data error, etc.).
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